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BAB IV
IMPLEMENTASI
4.1 Penerapan Aplikasi
Aplikasi ini termasuk kedalam aplikasi multimedia yang memiliki kategori sebagai sebuah media presentasi penjualan dan media virtual reality. Aplikasi ini dikatakan sebagai presentasi penjualan karena merepresentasikan penjualan produk rumah. Selain mereprentasikan pruduk rumah, aplikasi ini dapat memvisualisasikan produk rumah. Jadi aplikasi ini nantinya akan diterapkan sebagai media bantu visualisasi produk rumah dan sebuah media bantu merepresentasikan informasi mengenai produk rumah yang ditawarkan. 
4.2 Batasan Implementasi

Sesuai dengan kebutuhan sistem berdasarkan analisis sistem yang telah dilakukan, berikutnya akan dipaparkan batasan-batasan untuk implementasi. Batasan-batasan tersebut merupakan penyesuaian antara kebutuhan sistem dengan sumber daya pengembangan. Batasan-batasan implementasi tersebut, adalah : 

1. Animasi 3 Dimensi Pada Archicad diterapkan dengan cara interaktif yang mana animasi 3 dimensi tersebut di visualisasikan dengan bentuk video animasi.

2. Informasi yang diberikan mengenai profile perusahaan, keterangan mengenai pemasaran perumahan, dan visualisasi 3 dimensi rumah yang dipasarkan.

3. Hasil akhir akan berupa sebuah CD Interaktif.

4.3 Kebutuhan Hardware dan Software
4.3.1 Kebutuhan Hardware
Lingkungan perangkat keras yang digunakan pada saat melakukan tahap implementasi hasil perancangan Animasi 3 Dimensi Pada Archicad adalah sebagai berikut:

1. PC dengan dengan prosesor P IV LGA 2.66.

2. Vga 256 MB

3. Ram 512.

4. Hardisk 80 GB.

5. Monitor SVGA.
4.3.2 Kebutuhan Software
Perangkat lunak yang di butuhkan dan langkah pengerjaan pada saat pembangunan Animasi 3 Dimensi terdiri dari :

4.3.2.1 Pembuatan Animasi 3D rumah.

Pembuatan animasi 3D menggunakan ArchiCAD 9.0. Aplikasi ini digunakan untuk membuat produk rumah 3D. Adapun langkah pembuatan dari produk rumah 3D adalah sebagai berikut:
I. Pembuatan Produk Rumah 3D.

Untuk pembuatan rumah 3D dalam ArchiCAD menggunakan beberapa elemen-elemen kontruksi yang digabungkan hingga menjadi sebuah produk rumah. Adapun langkah yang dilakukan dalam pembuatan produk 3D rumah sebagai berikut :
A. Pengaturan bidang gambar dan kerja.

1. Pengaturan Skala.

Skala adalah ukuran perbandingan gambar kerja anda dengan ukuran bangunan sebenarnya pada kondisi asli.

Untuk mengatur skala gambar, anda bisa mengakses melalui menu Option > Floor Plan Scale.
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Gambar 4.1. Tampilan menu Floor Plan Scale

Akan muncul kotak dialog Scale (Floor Plan). Plih skala dengan menu drop down yang ada atau anda bisa mengetik sendiri skala yang anda inginkan dengan memilih custom dan ketikan angka skala anda pada kotak yang tersedia. Lalu pilih OK
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Gambar 4.2. Kotak dialog Scale (Floor Plan).

2. Pengaturan Preferences.

Pengaturan ini digunakan untuk menentukan parameter setting tersendiri sesuai dengan kebutuhan anda. 
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Gambar 4.3. Preferences
B. Pengaturan dan penggambaran Elemen Kontruksi.

1. Dinding ( Wall Tool ).

Dinding merupakan elemen utama untuk membuat sebuah bangunan dalam arsitektur. Adapun tools yang digunakan dalam pembuatan dinding adalah :

b. Pengaturan Parameter / Setting Dinding.

Anda dapat mengakses icon Door Tool di panel Basic yang ada di Toolbox.
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Gambar 4.4. Tool Wall
Kemudian pilih tombol Tool Setting Dialog yang terletak dibagian atas Info Box
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Gambar 4.5. Info Box Wall Tool
Tool Setting Dialog berfungsi sebagai pengaturan parameter dari Wall Tool dan juga dapat berfungsi untuk memodifikasi Wall Tool.
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Gambar 4.6. Wall Setting Dialog.

c. Menggambar Dinding.
1. Pilih jenis dinding PolyWall. Atur parameternya, tinggi dinding 300 cm, dan tebal dinding 15 cm.
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Gambar 4.7. Info Box Wall Tool
2. Perhatikan Gambar 4.9 dibawah. Aktifkan Grid Snap dan klik pada posisi klik 1.

3. Tekan r, ketik 250. Tekan a, ketik 0. Tekan Enter.
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Gambar  4.8. Input panjang dan sudut rotasi

4. Tekan Enter. Tekan r, ketik 100. Tekan a, ketik -90. Tekan Enter.   

5. Tekan Enter. Tekan r, ketik 300. Tekan a, ketik 0. Tekan Enter.

6. Tekan Enter. Tekan r, ketik 600. Tekan a, ketik 90. Tekan Enter.

7. Tekan Enter. Tekan r, ketik 550. Tekan a, ketik 180. Tekan Enter.

8. Tekan Enter. Tekan r, ketik 500. Tekan a, ketik -90. Tekan Enter.  
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Gambar 4.9.  Hasil penggambaran dinding

2. Jendela ( Window Tool ).

Jendela merupakan elemen dalam arsitektur yang memiliki fungsi utama sebagai ventilasi, tempat masuk atau mengalirnya udara ke dalam ruangan. Tools yang digunakan dalam pembuatan jendela adalah :

a. Mengatur Parameter/Setting Jendela.

Anda dapat mengakses icon Window Tool di panel Basic yang ada di Toolbox.
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Gambar 4.10. Window Tool 

Kemudian pilih tombol Tool Setting Dialog yang terletak dibagian atas Info Box.
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Gambar 4.11. Info Box Window Tool.

Tool Setting Dialog berfungsi sebagai pengaturan parameter dari Window Tool dan juga dapat berfungsi untuk memodifikasi Window Tool.

Anchor Point Digunakan sebagai acuan dalam penggambaran jendela.
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Gambar 4.12. Window Setting Dialog
b. Menggambar Jendela

Prinsip dasar menggambar jendela berdasarkan pada titik acuan (Anchor Point ) di tengah atau dipinggir yang akan gunakan.

1. Jika titik acuan di tengah.

· Klik pertama : untuk menempatkan jendela pada bidang dinding sekaligus menentukan posisi bukaan jendela anda, apakah menghadap ke dalam atau ke luar.

· Klik kedua : untuk mengakhiri penggambaran.
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Gambar 4.13. Gambar titik acuan di tengah.

2. Jika titik acuan di pinggir

· Klik pertama : untuk menempatkan jendela pada bidang dinding.

· Klik kedua : untuk mendefinisikan posisi penempatan jendela, apakah disebelah kanan atau kiri klik 1

· Klik ketiga : untuk mendefinisikan arah hadap jendela sekaligus mengakhiri penggambaran.
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Gambar 4.14. Gambar titik acuan di pinggir.

3. Pintu ( Door Tool ).

Pintu merupakan elemen arsitektur yang memiliki fungsi sebagai tempat masuk atau akses sirkulasi antar ruangan di dalam bangunan. Adapun tools yang digunakan dalam pembuatan jendela adalah :

a. Mengatur Parameter / Setting Pintu.

Anda dapat mengakses icon Door Tool di panel Basic yang ada di Toolbox. 
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Gambar 4.15. Door Tool
Kemudian pilih tombol Tool Setting Dialog yang terletak dibagian atas Info Box.
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Gambar 4.16. Info Box Door Tool.

Tool Setting Dialog berfungsi sebagai pengaturan parameter dari Door Tool dan juga dapat berfungsi untuk memodifikasi Door Tool.

Anchor Point Digunakan sebagai acuan dalam penggambaran Pintu.
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Gambar 4.17. Door Setting Dialog.

b. Menggambar Pintu.

Prinsip dasar menggambar pintu hampir sama dengan menggambar jendela. Hanya saja ketika melakukan klik terakhir untuk mengakhiri proses penggambaran, anda harus jelu meletakan posisi kursor, karena akan mempengaruhi kemana arah bukaan objek pintu anda.

1.
Jika titik acuan di tengah.

· Klik pertama : untuk menempatkan pintu pada bidang dinding sekaligus menentukan di mana letak pintu anda, apakah membuka kedalam atau keluar.

· Klik kedua : untuk mengakhiri penggambaran.
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Gambar 4.18. Gambar titik acuan di tengah.

2. Jika titik acuan di pinggir.

· Klik pertama : untuk menempatkan pintu pada bidang dinding.

· Klik kedua : untuk mendefinisikan posisi penempatan pintu, apakah di sisi sebelah kanan atau sebelah kiri klik 1.

· Klik ketiga : untuk mendefinisikan arah hadap pintu sekaligus mengakhiri penggambaran.
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Gambar 4.19. Gambar titik acuan di pinggir.

4.
Lantai/Plafond ( Slab Tool ).

Lantai merupakan elemen kontruksi horizontal yang berada di bagian bawah bangunan. Sedangkan plafond merupakan elemen kontruksi horizontal yang berada di bagian atas bangunan. Adapun tools yang digunakan dalam pembuatan jendela adalah :

a. Mengatur Parameter / Setting Lantai / Plafond.

Anda dapat mengakses icon Door Tool di panel Basic yang ada di Toolbox.
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Gambar 4.20. Slab Tool
Kemudian pilih tombol Tool Setting Dialog yang terletak dibagian atas Info Box.
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Gambar 4.21. Info Box Slab Tool
Tool Setting Dialog berfungsi sebagai pengaturan parameter dari Slab Tool dan juga dapat berfungsi untuk memodifikasi Slab Tool.
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Gambar 4.22. Slab Dialog Setting.

b. Menggambar Lantai.

Prinsip menggambar lantai berdasarkan variasi jenisnya.

· Pilih jenis lantai/plafond polygon di panel info box.

· Untuk membuat sebauh bidang lantai/plafond berbentuk berbentuk segiempat atau persegi, membutuhkan 5 kali proses klik, demikian seterusnya. Berikut anda akan berlatih menggambar bidang lantai/plafond berbentuk segitiga.

· Buka kotak dialog Slab Setting. Atur ketebalan lantai/plafond 10 cm dan tinggi dari permukaan 0 cm

· Klik jendela floor plan.

· Perhatikan gambar 4.23. Klik 1, lalu Klik 2, Klik 3, Klik 4, dan kembali Klik 1.
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Gambar 4.23. Posisi klik menggambar lantai.

5.
Atap ( Roof Tool ).

Atap merupakan elemen kontruksi paling penting / fundamental dalam arsitektur, karena merupakan penutup bagian atas bangunan. Adapun tool yang digunakan dalam pembuatan atap adalah :

a. Mengatur Parameter / Setting Atap.

Anda dapat mengakses icon Roof Tool di panel Basic yang ada di Toolbox. 
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Gambar 4.24. Roof Tool
Kemudian pilih tombol Tool Setting Dialog yang terletak dibagian atas Info Box.
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Gambar 4.25. Info Box Roof Tool.
Tool Setting Dialog berfungsi sebagai pengaturan parameter dari Roof Tool dan juga dapat berfungsi untuk memodifikasi Roof Tool.
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Gambar 4.26. Dialog Tool Setting Slab.

b. Menggambar Atap.

Prinsip menggambar atap berdasarkan variasi jenisnya.

· Pilih jenis atap polygon di panel info box.

· Berikut anda akan menggambar bidang atap berbentuk persegi.

· Buka kotak dialog Roof Setting. Atur tinggi atap dari permukaan 350 cm, sudut kemiringan atap 35º dan tebal list atap 20 cm.

· Klik jendela floor plan.

· Perhatikan gambar 4.27. Klik pada posisi Klik 1, lalu Klik 2. Amati bahwa kursor anda berubah menjadi tanda mata. Ini menandakan banwa anda harus menentukan pivot line atap. Jika anda memilih sisi kiri, maka atap akan jatuh / miring pada sisi sebelah kanan. Demikian sebaliknya. Klik pada posisi Klik 3.
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Gambar 4.27.  Posisi klik menggambar Atap.

· Setelah anda mendefinisikan pivot line, klik kembali pada posisi Klik 1, lalu Klik 2, Klik 3, Klik 4, Klik 5, dan kembali ke Klik 1. Maka atap sisi kanan anda telah selesai.

· Buat sisi atap sebelah kiri dengan urutan langkah yang sama seperti di atas, bedanya posisikan pivot line di sebelah kanan.

6. Objek aksesoris ( Object Tool ).

Objek aksesoris merupakan kumpulan liberary 2D/3D siap pakai yang bisa anda gunakan untuk mengisi elemen interior maupun eksterior bangunan anda berikut lingkungan ( environment ) sekitarnya, seperti vegetasi ( tanaman ), orang, mobil, dan lain-lain. Adapun tool yang digunakan dalam pembuatan objek aksesoris.

a. Mengatur Parameter / Setting Objek Aksesoris.

Anda dapat mengakses icon Object Tool di panel Basic yang ada di Toolbox. 
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Gambar 4.28. Object Tool
Kemudian pilih tombol Tool Setting Dialog yang terletak dibagian atas Info Box.
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Gambar 4.29. Info Box Object Tool. 

Tool Setting Dialog berfungsi sebagai pengaturan parameter dari Object Tool dan juga dapat berfungsi untuk memodifikasi Object Tool.
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Gambar 3.30. Dialog Tool Setting Object.

b. Menggambar Objek Aksesoris.

Prinsip dasar menggambar objek dalam Archicad adalah yang paling mudah, dibandingkan dengan menggambar elemen kontruksi lain, karena pada dasarnya angda tinggal meletakan objek-objek tersebut ke dalam gambar anda di jendela floor plan. Contoh objek yang akan digunakan yaitu mobil.
· Tampilkan kotak dialog Objects Setting. Buka subfolder Vehicles, pilih mobil yang anda inginkan.

· Biarkan setting default panjang dan lebar objek. Anda hanya perlu mengatur titik acuan keposisi yang anda inginkan. Setelah sesuai dengan keinginan anda. Klik OK.

· Perhatikan Gambar 4.31. Klik pada posisi Klik 3 
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Gambar  4.31. Posisi Klik Penempatan Objek

7. Lampu ( Lamp Tool ).

Sumber cahaya utama dalam ArchiCAD adalah sinar matahari ( daylight ). Namun demikian, anda dapat menggunakan Lamp Tool untuk menempatkan sumber cahaya tambahan kedalam project gambar anda. Terutama sebagai sumber cahaya untuk menerangi interior/ruangan dalam rumah.

Pencahayaan (lightning) dalam arsitektur memegang peran yang sangat penting. Penempatan sumber cahaya yang baik akan membantu membentuk karakter ruang yang kuat/unik dan ”sense of space” yang menarik dangan menghadirkan daerah terang  yang tercipta.

a. Mengatur Parameter / Setting Lampu.

Anda dapat mengakses icon Lamp Tool di panel Basic yang ada di Toolbox. 
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Gambar 4.32. Lamp Tool
Kemudian pilih tombol Tool Setting Dialog yang terletak dibagian atas Info Box.
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Gambar 4.33. Info Box Lamp Tool.

Tool Setting Dialog berfungsi sebagai pengaturan parameter dari Lamp Tool dan juga dapat berfungsi untuk memodifikasi Lamp Tool.
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Gambar 4.34. Dialog Tool Setting Lamp.

b. Menggambar Lampu.

Prinsip dasar menggambar lampu dalam ArciCAD sama seperti menggambar objek aksesoris. Contoh penggambaran lampu yang akan kita lakukan adalah menggambar sebuah lampu taman.

· Pilih tool lamp yang ada pada Toolbox. 

· Lalu pilih kotak dialog setting. Buka folder Street Lamps, pilih lampu yang diinginkan.

· Biarkan setting default yang ada. Anda hanya perlu memastikan titik acuan (hotspot) tepat berada di tengah objek. Klik OK.

· Perhatikan gambar 4.35. Klik posisi yang ditunjuk pada gambar.
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Gambar 4.35. Posisi klik Penempatan Lampu.

II. Pembuatan Animasi.

Pembuatan animasi yang dapat dilakukan dengan menggunakan ArchiCAD yaitu dengan membuat susunan objek-objek kamera secara berurutan hingga membentuk jalur animasi. Animasi seperti ini sering disebut dengan animasi berjalan atau walkthrough. Adapun langkah yang dilakukan dalam pembuata animasi ini adalah sebagai berikut. 
A. Tools Camera & Setting.

Anda dapat membuat objek kamera pada gambar bangunan dalam ArchiCAD. Anda dapat membuat lebih dari satu objek kamera, di mana setiap objek kamera berdiri sendiri. Dari objek kamera yang dibuat anda dapat melihat bangunan secara 3D. Tampilan 3D yang dihasilkan dari objek kamera sesuai dengan posisi objek kamera pada gambar. Adapun tool yang dapat digunakan dalam penggambaran camera adalah
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Gambar 4.36. Camera tool.

Ketika icon camera tool diaktifkan, secara otomatis kotak panel info box akan menampilkan opsi pengaturan untuk elemen kamera.
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Gambar 4.37. Info Box Camera

Dalam info box ini anda dapat mengakses dialog setting camera atau memilih jenis kamera yang akan digunakan.
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Gambar 4.38. Setting Camera
B. Pembuatan Animasi.
Setelah pemilah dan pengaturan kamera selesai maka dapat dibuat animasi. Adapun cara yag dapat dilakukan dalam pembuatan animasi adalah sebagai berikut :
· Bukalah file bangunan yang anda ingin berikan kamera.

· Dalam tombol Toolbox klik tombol Camera seperti pada gambar 3.36.

· Perhatikan gambar 4.39. secara langsung anda klik pada posisi klik 1 dan klik 2 untuk membuat objek kamera pertama.
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Gambar 4.39. Posisi klik membuat 4 kamera. 

· Dilanjutkan dengan mengklik pada posisi klik 3 dan klik 4 untuk membuat objek kamera kedua.

· Klik pada posisi klik 5 dan klik 6 untuk objek kamera ketiga.

· Terakhir klik pada posisi klik 7 dan klik 8 untuk objek kamera keempat.

III. Rendering.

Rendering merupakan proses akhir yang dilakukan untuk menghasilkan sebuah produk animasi 3D rumah. Setelah proses penempatan kamera pada posisi Klik 8 selesai dan ingin dibuat sebuah hasil akhir maka lakukan langkah seperti dibawah ini.
1. Sebelum menggunakan menu Create Fly-Through, ada langkah pertama yang harus dilakukan yaitu melakukan pengaturan pada PhotoRendering Setting. Karena format akhir yang akan digunakan adalah PhotoRendering Window. Untuk pengaturan dapat dilihat sebagai berikut :

A. Pengaturan Image Size dan Effect.
Kotak image size & effect digunakan untuk mengatur ukuran gambar, resolusi gambar, kualitas, tampilan efek dan sumber pencahayaan serta bayangan dari gambar PhotoRendering Anda. Adapun pengaturan yang dilakukan adalah :
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Gambar 4.40. Image Size & Effect
· Rendering Engine yang digunakan adalah Inernal Rendering Engine.
· Ukuran yang digunakan adalah 1024 * 768 pixel dengan resolusi 100 dpi.

· Dalam kotak Method klik Best.

· Dalam kotak Antialiasing klik Best.

· Dalam kotak Effek klik Highlight, Emission, Transparancy, smooth Suface, Lamp Falloff, dan Textures.

· Dalam kotak Light Source pilih Sun dan Lamp.

· Dalam kotak Shadow Casting klik High Accuracy dan Use Transparancy.  

B. Pengaturan Background.

Kotak background digunakan untuk mengatur latar belakang dari gamgar PhotoRendering anda. Anda bisa menampilkan warna ataupun gambar still image untuk menjadi latar belakang gambar bangunan ketika dieksekusi menjadi gambar PhotoRendering. Disini kita gunakan background untuk memberikan kesan nyata pada hasil render nantinya.
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Gambar 4.41. Background.

2. Klik menu image | Create Fly-Through atau tekan F11 pada keyboard. Lalu akan muncul dialog setting Create Fly-Through seperti Gambar 4.42.
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Gambar 4.42. Kotak Dialog Create Fly-Through.

3. Setelah tampil kotak dialog Create Fly-Through seperti pada Gambar 4.42. Dalam format output pastikan pilih PhotoRendering Window untuk menghasilkan suatu kualitas dan tampilan yang baik.
4. Setelah ditentukan format output, lalu tentukan format file yang akan digunakan. Pilih format Windows BMP Image.
5. Setelah semua proses dilakukan lalu klil tombol Save untuk melakukan proses rendering.

4.3.2.2 Video Animasi.
Untuk pembuatan video animasi dilakukan menggunakan software Ulead Video Studio 8. Aplikasi ini digunakan untuk mengabungkan beberapa gambar hasil proses rendering yang dilakukan dengan menggunakan aplikasi ArchiCAD 9.0 menjadi sebuah produk video dengan format .Mpeg. format mpeg yang memiliki kualitas DVD dengan ukuran 720 X 576 pixel.
1. Dalam Ulead VideoStudio 8 memiliki dua pilihan menu, VideoStudio Movie Wizard dan VideoStudio Editor. Pilih menu VideoStudio Editor.  
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Gambar 4.43. Menu Ulead VideoStudio.

2. Setelah anda memilih menu VideoStudio Editor, lalu pilih menu Edit.

3. Dalam menu Edit kita harus mengambil gambar hasil proses rendering dari ArchiCAD 9 melalui library.
4. Dalam library terdapat menu dropdown yang di dalamnya terdapat pilihan Video, Image, Color, Transition, Video Filter, Title, dan Decoration.  pilih Image, lalu tekan tombol load image.
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Gambar 4.44. Tampilan Pilihan menu load image
5. Setelah gambar terpilih dan masuk dalam library, lalu tarik gambar yang akan digunakan sebagai video animasi ke timeline.
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Gambar 4.45. Tampilan proses input ke timeline.

6. Setelah itu lakukan pengaturran durasi waktu untuk setiap gambarnya agar terlihat seperti gambar bergerak di Option Panel. Gunakan durasi 3 milidetik ( 0:00:00:03 ).
7. Setelah itu lalu pilih menu Share untuk melakukan proses akhir dalam pembuatan Video Animasi.

8. Dalam menu Share pilih Create Video File yang ada pada Option Panel Share..
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Gambar 4.46. Tampilan menu Share.

9. Pilih Costom dalam menu Create Video File.
10. Pilih Save Tipe untuk format akhir yang ingin, pilih mpeg lalu pilih Option untuk pengaturan dari format file MPEG files(*.mpg).
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Gambar 4.47. Menu Costum pada Create Video File.

11. Gunakan menu Option untuk melakukan pengaturan, pilih menu General untuk mengubah ubah Frame type menjadi Frame-based, lalu ubah Frame rate menjadi 25 frame/second, setelah itu ubah Frame size menjadi 720 X 576 pixel.
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Gambar 4.48. Menu General pada menu Option.

12. Setelah pengaturan General selesai lalu lakukan pengaturan pada menu Compression.
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Gambar 4.49. Menu Compression pada menu Option.

13. Dalam menu ubah Media type menjadi PAL DVD, setelah itu geser scroll bar kearah Quality, setelah itu ubah Video data rate menjadi Constant Bit Rate. Setelah semuanya selesai lalu klik tombol OK.

14. Setelah itu menu kembali ke menu sebelumnya dapat dilihat pada Gambar 4.47. Berikan nama file lalu tekan tombol Save untuk melakukan proses render.  
4.3.2.3 Pembuatan Interaktif.

Pembuatan interaktif menggunakan Macromedia Director MX. Aplikasi ini digunakan untuk membuat suatu produk multimedia yang dapat berinterktif dengan pengguna. Sebagai contoh kita ambil pembuatan interaktif pada menu produk rumah :
1. Pada saat program Macromedia Director dibuka kita dapat langsung melakukan pekerjaan. Karena pada saat masuk, Director sudah membuatkan anda sebuah pryek baru.

2. Sebelum kita memulai pekerjaan yang harus diperhatikan kita akan membuat proyek ini menggunakan movie ukuran berapa. 

3. Untuk melakukan perubahan ukuran movie yang akan digunakan dapat dilakukan pada panel Property Inspector. Ubah ukuran movie menjadi 800 X 600.
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Gambar 4.50. Tampilan Movie Property Inspector.

4. Untuk membuat proyek interaktif kita memerlukan objek  lain untuk memperindah disain dari proyek ini. Jadi kita harus menggunakan objek lain seperti gambar, animasi, audio, dan video yang telah dirancang untuk pembuatan proyek interaktif ini.
5. Untuk melakukan import objek dapat dilakukan langsung pada panel Cast dengan melakukan klik kanan  lalu pilih Import atau dapat menggunakan menu File > Import.
6. Untuk objek video memiliki cara yang berbeda dalam melakukan import atau memasukan objeknya ke dalam stage. Kita harus menambahkan Xtras karena format standar dari Director MX tidak menyediakan fasilitas import atau memasukan file video dengan format *.MPG.

7. Xtras merupakan suatu fasilitas yang sudah ada dalam director, akan tetapi Xtras dapat ditambah sesuai dengan kebutuhan.. Xtras yang digunakan untuk melakukan Import objek video dengan format *.MPG adalah DirectMediaXtra.x32

8. Cara menambahkan Xtras ke dalam Director yaitu dengan cara  DirectMediaXtra.x32 ke folder Program Files / Macromedia / Director MX / Xtras di Komputer anda. Tapi sebelum meng-copy Xtras tersebut kita harus menutup aplikasi Macromedia Director.
9. Sekarang anda mempunyai menu Insert > Tabuileiro Xtras > DirectMedia Xtra.
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Gambar 4.51. Tampilan menu DirectMedia Xtra.
10. Untuk mengimport file *.MPG dengan  DirectMedia Xtra, klik menu Insert > Tabuileiro Xtras > DirectMedia Xtra, maka tampil kotak dialog sebagai berikut :
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Gambar 4.52. Tampilan Dialog DirectMedia Xtra.
11. Klik tombol Browse File, pilih all.Mpg.
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Gambar 4.53. Tampilan Browse File DirectMedia Xtra
12. Sebelum kita melakukan semua proses Import, kita dapat melakukan pembagian jenis objek yang akan digunakan pada Cast dengan menggunakan tombol Choose Cast lalu pilih New Cast. Ini dilakukan untuk mempermudah kita dalam pencarian objek yang akan kita gunakan.  
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Gambar 4.54. Tampilan Cast.

13. Setelah semua objek di import dan digolongkan seperti pada Gambar 4.54. lalu susunlah objek-objek yang ada pada Cast dengan cara menarik objek-objek yang ada pada Cast tersebut ke arah Stage hingga tampak seperti pada gambar di bawah ini.
[image: image55.jpg]



Gambar 4.55. Tampilan Stage.

14. Setelah semua objek-objek ditarik dan disusun pada stage maka otomasi objek-objek yang berada pada stage juga ada panel Score. 
15. Lakukan pengaturan objek-objek yang telah digunakan pada Stage sesuai dengan urutan kemunculan yang di inginkan pada Score Channel.
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Gambar 4.56. Tampilan Score.

16. Setelah dilakukan pengaturan pada Score Channel seperti pada Gambar 4.56 lalu kita jalankan proyek maka proyek akan berjalan mulai dari frame pertama hingga selesai tidak berhenti pada frame yang diinginkan.
17. Untuk mengatur pada frame berapa playback head harus berhenti kita dapat menggunakan Script Channel. Dengan cara melakukan double klik pada Script Channel di posisi akhir frame yang telah disusun pada Score Channel, seperti terlihat pada Gambar 4.56.

18. Adapun script yang harus diketik pada script panel agar frame berhenti pada frame yang diinginkan dapat dilihat pada Gambar 4.57.
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Gambar 4.57. Tampilan Script Panel
19. Setelah mengatur semua urutan berhentinya frame yang diinginkan. Baru kita dapat memberikan interaktif pada proyek ini. Sebagai contoh kita akan membuat salah satu proses interaktif yang ada pada proyek ini.
20. Untuk membuat suatu proses interaktif dapat dilakukan dengan beberapa cara tapi sekarang kita akan menggunakan marker. Marker di sini digunakan sebagai penunjuk frame yang akan dituju dan nantinya digunakan dalam script.
21. Adapun cara membuat marker dapat dilakukan dengan cara melakukan klik pada Marker Area lalu beri nama merker tersebut. Seperti yang terlihat pada Gambar 4.56. sebagai contoh kita beri nama marker dengan nama V.T.Dpn. marker ini digunakan untuk menampilkan video animasi produk rumah mulai dari luar hingga kedalam.
22. Proses interaktif diterapkan pada gambar rumah seperti yang terlihat pada Gambar 4.55. Pada gambar rumah ini kita berikan behavior.

23. Behavior ini digunakan untuk untuk memberikan event dan action pada gambar rumah tersebut. 

24. Untuk memberikan behavior kita gunakan tombol Behavior Popup lalu pilih New Behavior.   
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Gambar 4.58. Tampilan Behavior Inspector
25. Pilih New Behavior, lalu akan muncul dialog box untuk memasukan nama behavior tersebut. Sebagai contoh kita beri nama VTD maka behavior inspector akan berubah jadi seperti gambar dibawah ini :
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Gambar 4.59. Tampilan behavior baru.

26. Setelah terbentuk behavior baru, kita tambahkan Action dengan menekan tombol Action Popup lalu pilih Action Mouse Down. Setelah Action dipilih maka tampilan akan berubah menjadi seperti gambar dibawah ini :
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Gambar 4.60. Behavior yang ditambah Action dan Event
27. Setelah itu klik teks mouseDown untuk memberikan Action pada event tersebut. Untuk memberikan action pada event dengan menekan tombol Action Popup lalu akan muncul menu.
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Gambar 4.61. Menu Action 

28. Pilih menu Navigation lalu pilih Go to Marker, maka akan muncul kotak diaog untuk memilih marker yang akan digunakan. Kita akan pilih V.T.Dpn  sebagai marker yang akan kita gunakan. Lalu tekan tombol OK
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Gambar 4.62. Kotak dialog Go to Marker. 

29. Setelah itu jalankan proyeknya dan coba proses interaktif tadi. Untuk interaktif yang lain memiliki langkah yang sama seperti langkah-langkah diatas.
4.4 Implementasi Antar Muka

Implementasi antar muka merupakan penerapan layout yang telah dirancang. Implementasi antar muka meliputi :

4.2.1. Intro
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Gambar 4.63. Intro

Tabel 4.1. Keterangan Halaman Intro
	NO
	KETERANGAN

	1.
	Tombol keluar dari intro untuk masuk ke menu utama


4.2.2. Menu Utama
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Gambar 4.64. Menu Utama

Tabel 4.2. Keterangan Menu Utama
	NO
	KETERANGAN

	1.
	Tombol profile perusahaan

	2.
	Tombol produk rumah

	3.
	Tombol keterangan

	4.
	Tombol kontak

	5
	Halaman informasi menu utama


4.2.3. Menu Profile
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Gambar 4.65. Menu Profile

Tabel 4.3. Keterangan Menu Profile

	NO
	KETERANGAN

	1.
	Tombol visi & misi perusahaan 

	2.
	Tombol sejarah perusahaan

	3.
	Tombol struktur organisasi perusahaan

	4.
	Tombol kembali ke menu utama.

	5.
	Halaman penjelasan dari tombol visi & misi, sejarah, dan Struktur  


4.2.4. Menu Produk

[image: image66.jpg]SE-3CIC IC-IC-IC-IC-IC IC-IC I IC-IC-ICOT A0 ICOC I8

— =
K iz whlan
2 beprieaae Nyd

7 e T e L




Gambar 4.66. Menu Produk

Tabel 4.4. Keterangan Menu Produk

	NO
	KETERANGAN

	1.
	Tombol Produk Tipe 36 / 84 

	2.
	Tombol Produk Tipe 42 / 90

	3.
	Tombol Produk Tipe 48 / 112

	4.
	Tombol kembali ke menu utama.


4.2.5. Menu Tipe 36, Tipe 42, dan Tipe 48 
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Gambar 4.67. Menu Tipe 36, Tipe 42, dan Tipe 48 

Tabel 4.5. Keterangan Menu Tipe 36, Tipe 42, dan Tipe 48
	NO
	KETERANGAN

	1
	Tombol untuk melihat kamar tidur utama

	2
	Tombol untuk melihat kamar mandi

	3
	Tombol untuk melihat kamar tidur

	4
	Tombol untuk melihat ruang belakang

	5
	Tombol untuk melihat ruang tengah

	6
	Tombol untuk melihat ruang tamu 

	7
	Halaman untuk menampilkan gambar dan video dari tiap ruangan yang dipilih dan juga sebagai tombol  play video.

	8
	Tombol untuk melihat ruangan yang berikutnya

	9
	Tombol untuk melihat ruangan yang sebelumnya

	10
	Tombol untuk kembali ke menu produk


4.2.6. Menu Keterangan
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Gambar 4.68. Menu Keterangan

Tabel 4.6. Keterangan Menu Keterangan

	NO
	KETERANGAN

	1
	Tombol harga produk rumah yang dijual

	2
	Tombol syarat pembelian dengan cara tunai

	3
	Tombol syarat pembelian dengan cara KPR

	4
	Tombol fasilitas yang ditawarkan pengembang

	5
	Tombol lokasi perumahan

	6
	Tombol kembali ke menu utama 

	7
	Halaman untuk menampilkan informasi dari tombol 1 sampai 5.


4.2.7. Menu Kontak
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​​​​
Gambar 4.69. Menu Kontak 

Tabel 4.7. Keterangan Menu Kontak
	NO
	KETERANGAN

	1
	Halaman untuk menampilkan informasi tentang kontak

	2
	Tombol ke menu utama


4.5 Spesifikasi Modul
Modul yang dirancang dalam aplikasi ini merupakan tempat berlangsungnya proses-proses penampilan informasi. Maksuk dari spesifikasi modul adalah untuk memberikansuatu kemudahan terhadap pengguna (user).Untuk lebih jelasnya dapat dilihat dari tabel spesifikasi moduk berikut :
Tabel 4.8. Tabel Spesifikasi Modul.
	NO
	NAMA MENU
	KETERANGAN

	1
	Intro
	Menu ini berisikan intro dari aplikasi sebelum memasuki menu utama.

	2
	Menu Utama
	Menu ini menampilkan beberapa pilihan informasi yang dapat digunakan oleh pengguna seperti Profile, Produk, Keterangan, dan Kontak

	3
	Profile
	Menu ini berisikan mengenai profile perusahaan, seperti visi & misi perusahaan, sejarah perusahaan, dan struktur organisasi.

	4
	Produk
	Menu ini menampilkan beberapa tipe produk rumah yang ditawarkan.  

	5
	Tipe 36 / 84,
Tipe 42 / 90,

Tipe 48 / 112.
	Menu ini menampilkan denah rumah, gambar tiap ruangan yang ada, dan video animasi dari tiap ruangannya.


	6
	Keterangan
	Menu ini menampilkan informasi mengenai pemasaran produk rumah, seperti harga produk rumah yang dipasarkan, syarat kepemilikan rumah, fasilitas yang ditawarkan, dan lokasi perumahan. 

	7
	Kontak
	Menu ini menampilkan informasi mengenai nama perusahaan, alamat perusahaan, dan nomor telepon yang dapat dihubungi.
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